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Retirement analysis

Retirement analysis

Retirement is often the core part of your clients’ financial plan. The goal of the retirement analysis is
to determine if the clients’ objectives can be met with expected income sources and withdrawals
from assets.

Learning objectives

This module will enable you to

* Define the retirement objective

* Analyze the retirement objective using output pages
* Discuss solutions to solve the retirement objective

Profiles Professional creates a retirement objective by default. You can use the existing default values
or you can override these fields using data specific to your clients’ situation. The retirement output
pages will help you assess your clients’ current situation and identify strategies that will solve the
retirement objective.

Learning tools

This module includes some practice exercises using one of the sample clients provided in the
application. If you want to keep this sample client case intact, open the Sample 4 - Comprehensive
(Jones - non-tax).fpx client case, and then save it with a new case name.

To open and save the client case, follow these steps:
1. Start Profiles Professional.
2. Click Open Existing Case, and then click Open Sample Case. The Open Sample Case screen opens.

3. Click the Open link beside Sample 4 - Comprehensive (Jones - non-tax).fpx. A Data Conversion dialog
box may appear to warn you that the planning preferences in this case differ from the global
planning preferences. Click Close.

4. Click the File menu — Save As. The Save Client Data As dialog box opens.
5. Save the case with a unique name, for example, Jones — Retirement Analysis Self-Study Guide.

Please keep in mind that the case we are using for this self-study guide does not have the Tax-Sensitive
option selected.

Learning objectives 1
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Define the retirement objective

[8J Profiles Professional - Comprehensive M=l E3
File Edit Input Output Tools Help
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Retirement
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With Dependents. Monthly Income Need FES
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John A& Smith Spend cash flow surplus |

Figure 1: Planning Preferences — Needs Preferences

On the Needs Preferences screen under Planning Preferences, you can set up the default retirement
values that define the retirement objective.

You can show the effect of spending the cash flow surplus instead of reserving it within the plan by
selecting the Spend Surplus Income check box.

By default, the Monthly Income Goal as % of Total Income is 70%.

The Capitalization Rate is the ordinary income return rate Profiles Professional will apply to the
required savings to calculate the savings that are needed to meet the goal.

2 Define the retirement objective
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Figure 2: Case Data — Retirement

On the Retirement screen under Case Data, you can define the time period and expenses for the
retirement goal. By default, Profiles Professional assumes that Client A retires at age 65, and Client B
retires in the same calendar year. You can override the default by entering different ages in the
Retirement Begins At Age fields. The Age to Begin Social Security Income field defaults to the full benefit
age, but this field can also be overridden if required.

Under Income Needs, you can set different monthly needs for different time periods throughout
retirement in today’s dollars. By default, 70% of current income is required. Remember that the
retirement default values are set on the Planning Preferences — Needs Preferences screen. To revert to the

default values, click the [ 21| (Restore Default) button on the toolbar.

You can set up two groups of monthly incomes indexed differently and change needs over time.
Enter the monthly incomes as gross expenses including taxes. For example, at age 65, the client may
have a Monthly Need (1) of $7,500 in living expenses that inflates at 3.5%, and a Monthly Need (2) of
$1,000 for a golf membership with no inflation. At age 75, Monthly Need (1) is $7,500 for living
expenses (no inflation) but Monthly Need (2) is $0, assuming the client is no longer able to golf.

Define the retirement objective 3
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Analyze the retirement objective using output pages

Reports
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Figure 3: Client Presentation — Reports

Now let’s take a look at some of the output pages that analyze retirement. When you use the Save As
PDF button to create the report in Portable Document Format (PDF), you can choose the location
where the PDF will be saved.

The Retirement Objective presentation page displays the clients” annual retirement expenses
throughout the planning period.

4 Analyze the retirement objective using output pages
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Retirement Objective
How much do you need?

M Resirement Income Objective

$600,000—

$500,000—

$400,000—

$300,000—

Annual Income

$200,000

63 65 67 69 71 73 75
59 61 63 65 67 69 71

77 79 81 83 85 87 ®9
73073 077079
Tom's Age
Marlyn's Age
Azsaming: Tomn's mortality age 90, Maribyn's mortaliny age 80

Your retirement income objective has been illustrated above. Your objective in the first year of
retirement results in the following:

81 83 85 87 8

Total annual income objective in first year $124,692

beginning of retirement. in an account eaming 7.00%. would be the following:

Total capitalized income objective

income sources (e.g.. Social Security) and withdrawals from assets (e.g.. 401(k), IRA).

In order to meet your meome objective throughout your retirement, the amount of money needed at the

The goal of the retirement analysis 1s to determune if your objective above can be met with expected

Tom and Marilyn Jones
Presented by: John A Smith

Figure 4: Client Presentation — Retirement — Retirement Objective

The first year of retirement need is shown as a future dollar amount. The total retirement income
objective is the capital amount needed at retirement. The rate used to define the capital amount is
defined on the Needs Preferences screen under Planning Preferences.

Next, let’s take a look at the Retirement Income Sources output page.

Analyze the retirement objective using output pages 5
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Retirement Income Sources
What income will be available?

M Social Seumity M Defined Benefit W Anvuiry Benefits Eamings Mc. Income

$250,000—

$200,000—

$150,000—

$100,000—

Annual Income

$30,000—

$0

63 65 67 69 71 73 75 77 79 81 83 85 B B9 - -
59 61 63 65 67 69 71 73 75 77 79 81 83 85 87 0
Tom's Age
Manlyn's Age
Azsaming: Tomn's mortality age 90, Maribyn's mortaliny age 80

Charted above are your expectad income sources. Income sources will be guaranteed to varying degress
and should be matched to the appropriate needs. Social Security benefits, for example, could be viewed
as fairly guaranteed when compared to the income from a personally managed rental property. Ideally,
the most important needs should be covered by your mest guaranteed income sources, while less
important needs can be coverad by less guaranteed income and mvestment assets.

Generally in this analysis, income sources are used to pay expenses each year before withdrawals from
assets are made. If there is more than enough income, the excess will be spent.

Tom and Marilyn Jones
Presented by: John A Smith

Figure 5: Client Presentation — Retirement — Retirement Income Sources

This presentation page provides an annual breakdown of the incomes available during retirement,
such as Social Security, defined benefit pensions, annuity income, earnings, etc. It answers the
question that your clients may be asking, “Where will our money come from?” This output page does
not include income from investment assets.

6 Analyze the retirement objective using output pages



Income Sources Applied to

Retirement Objective
Can your portfolio provide the rest?

W Social Secunty M Defined Benafit N Anmuity Benefits Earnings
Misc. Income M Retirement Income MNeed
$600.000—
$300.000—
E $400.000—
2
= $300.000
£
< $200,000

63 65 67 69 71 73 75 77 79 81 83 85 87 89 - -
50 61 63 65 67 69 71 73 73 77 79 81 83 85 87 9
Tom's Age
Marlyn's Age
Azsaming: Tomn's mortality age 90, Maribyn's mortaliny age 80

In the chart above, the analysis has applied your expected income sources against your retirement income
needs. In any year that a shortfall exists (where the total need is larger than the available income), the
analysis will attempt to cover the shertfall through withdrawals from your retirement assets (e.g. 401(k),
and IFA). In any year where there is more income than need, the excess income will be spent. The table
below summarizes the analysis so far.

Capitalized Value* Amount % of Total
Total capitalized mcome objective $4.283,177 100%

Capitalized applied income sources $1.701.979 40%
Capitalized amount needed from assets A 60%

*Capitalization 13 a way of treating a series of cash flows as a lump sum, depesited in a hypothatical account with 2
retum of 7.00%.

Tom and Marilyn Jones
Presented by: John A Smith

Figure 6: Client Presentation — Retirement — Income Sources Applied to Retirement Objective

Retirement analysis

This presentation page combines the two previous output pages to compare the income versus the
need. The table shows how much of the retirement need will have to be covered by assets (if any).

Analyze the retirement objective using output pages 7
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Retirement Analysis Results
Has the objective been met?

B Sovial Seurity Adlisal leome B Required Dearibaticns
Withdmwsls Bon Assets W Rssrenem Income Olrjective

5500, 000—

5500,000—
=
E 500,000
T 53000004
j 5200,000—

] 7@ Bl 8 BS -

63 65 &7 €9 71 73 75 77 T Bl 83 25 47 &80
Tom's Aze
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Admreeg. Toon's morsdly age W0, Medyn's sy age 50

Bazed on the analysis of your mtrement incoms nesds, sxpactad incoms sourcas and availabls ascets,
veoar objectve will be satisBed until 2z 70, The follewing tbls sursmarizes the resnles.

ﬂﬁ.ir_:m'r: E(ﬂ&‘f .Rnruz'nz'ng
Suceessfal years of retirament k] 1€ 15
Capitalizad valoe af retizemsat* £4 285177 53,438 748 5345,482%
Percent of goal 100 %

Thare zrs several mattods by widch yon can izoprovs your reenlis: save MOTs, aI0 MoTe 0T YOUT
savings, Tetire later, retme ez less or redncs other expezias.

Thase mewalts ars bypothstical and ars not 2 prossizs of futurs performencs.
*Capitalizasion & a wary of meating 2 saries of cash Bows 25 a hump s, doposited in 2 Eypothetizal accommt nitk a

ratum of 7.00%%. The Bewdis amount includes all incoma sooross e=d asset withdrawals applied to the reteenant
chjective

Tom and Mariyn Jones,
Presanted by Jos Fignner

Figure 7: Client Presentation — Retirement — Retirement Analysis Results

The Retirement Analysis Results presentation page (similar to the Capital Analysis page in version 7.6)
builds on the previous output pages. The graph looks at income sources and asset withdrawals and
shows how they measure up against the retirement objective. On screen, the graph colors are visible.
Red indicates an unmet objective. The orange spike when Tom reaches age 90 (marked with a box in
Figure 7) represents life insurance being redeemed. The table summarizes the successful years in
which the retirement objective is met and indicates the remaining capital needed at retirement to
achieve the retirement objective. Clients will want to know how to achieve this, which brings us to

the next output page.

8 Analyze the retirement objective using output pages
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Save More—Earn More
Achieving Your Retirement Objective

51200
L

£1.000—

Additienal -
Monthly s
Savings SE00—
Levall
F400—

5200

T00% | TEEWM | B2 | B8 £93% | 0.08%

Hypothetical Rave qf Remurm

Tha apalysis shows that thers are net snough assets to provide for your retirszaent needs. Thar ars onky
terae ways to fix this problen: 1) Reduce or delay your ratirement goal; 2) S2ve mese money; or 3)
Make vour money wark barder. Assumsing vou wazt to keep vour geals intacr, lat's examing the las: twa.
Save More:
At ratirement, yo need an addittonal $246,429 m 2 hypotketical axable account sarni=g 7.00% to
mast your goals. Savings of §1.042/me=th into this account would accomplish tis
Camraztly, yeur 2ssets am expected o earz 2o averags of 7.88%. If the Eypethetical accouzt ware
sarzing thiz rate too, thez you would need $B46,432 ar ratirement, raguising £910/me=th
Earm Alore:
I, bewravar, your refmemzezt assets could earn B.2E8%, czly $0/month weuld be necassary to achisve
your retirement goals. An incrsased return mm2y be possible terongh 2 reallocaticz of yoar 2ssets or by
urilizing tax-2dventaged accouzts, such as IRAs or 2zouttiss
The Eight Combinaction:
Cheanging your pestfolio rate from 7.88% o 8.58% reduces the additicnz] savings to $437T/montk.
Factars wack 2 risk tolerazcs, tmeframe and savizg abdicy caz halp you find the gkt combizatiez.

Tom and Marfyn Jones
Fresanted by. Jos Fianner

Figure 8: Client Presentation — Retirement — Save More--Earn More

The Save More—Earn More presentation page shows several ways in which the clients can reach their
goal if a shortfall exists. If there is no shortfall, this page is not available. In Figure 8, the left bar
shows that when assets earn the capitalization rate of 7.00% (specified on the Planning Preferences —
Needs Preferences screen), the clients will need to save an additional $1,042/month to meet the goal.
The right bar shows that, if they do not or cannot save additional dollars towards their retirement
goal, they need to earn 9.28% on existing assets. Most clients will choose something in between. If this
is what your clients want to do, you may want to talk to them about reallocating their assets to
increase their return. By reallocating their assets and investing more money, they should be on track
to meet their retirement objective.

Analyze the retirement objective using output pages 9
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Discuss solutions to solve the retirement objective

Before trying to solve the retirement objective, it is important to save the current case as the starting
point by selecting the File menu — Save As, and then giving the case a new descriptive name. In this
new case, you can try different strategies to solve the retirement objective. For example, you might try
reallocating assets to increase their rate of return, saving an additional $500 per month to any
investment account asset, delaying retirement by two years, or reducing the retirement goal by $500
per month. After trying a strategy, you can generate the Retirement Analysis Results output page again
to see if the shortfalls disappear. Once the shortfalls disappear, you know that you have solved the
objective. However, you still need to make sure that the clients can afford the recommended savings
amounts by reviewing various cash flow output pages.

One of the first things you may want to look at when solving the retirement objective is asset
reallocation. Clicking the Complete Questionnaire button on the Risk Tolerance Profile screen opens a
questionnaire that you can use to determine which investment portfolio best matches your clients’
objectives. The resulting profile is based on Ibbotson information and on the clients” score on the
questionnaire. The clients” portfolio may differ for each goal based on the time horizon.

m Profiles Professional - Comprehensive [_ (O] x| I
File Edit Input Output Tools Help
o P W - [ -~ = W
| 8§ HD & & i K D
e e ~
Profiles Professional . .
Risk Tolerance Profile
Risk Tolerance
Question 1 b. Portfolio 2 =
Question 2 Ib_ Fartfolio B j
Question 3 Ic:. Balance moderate riskreturns j
Question 4 Ib. “Wait at least a year before change j
Question 5 Ic:. Fartfolio C j
Question & Ia_ Agres j
FRiizk tolerance profile: Moderate Aggreszive
LComplete Questionnaire |
Back | Mext |
John & Smith | Question 1 - Risk Tolerance |

Figure 9: Case Data — Risk Tolerance Profile

A printable risk tolerance questionnaire is available from the Tools menu — Printable Forms — Modular
Fact Finders - Assessments — Risk Tolerance Questionnaire.

10 Discuss solutions to solve the retirement objective
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1s a potential for higher retums.

a. Agree (13 points)
b. Disagree (2 points)

above.

¢. Strongly disagree (0 points)

Your Risk Tolerance Score: 62 out of 100

6. Iam comfortable with investments that may frequently experience large declines in value if there

In the table below. you will find a description of the risk tolerance profile that most closely fits the score

Risk Tolerance Profile

Score Prafile

Descnption

0-19 Conservativ

The conservative investor is particularly sensitive
to short-term lesses. but still has the goal of
beating expected inflation over the long mn.

20-39 Moderate
Conservative

The moderate conservative mmvestor 1s sensitive to
short-term losses, but 1s willing to aceept more risk
than the conservative investor in order to pursue
higher potential retuns over the leng-term. The
safety of investment and retum is of relatively
equal importance to the moderate conservative
nvestor.

40-59 Moderate

The moderate investor is willing to accept some
risk. but is probably not willing to accept the
short-term risk associated with achieving a
long-term return substantially above the inflation
rate.

60-79 Moderate
Aggressive

The moderate aggressive mvestor is concemed
primarily with wealth accumulation over an
intermediate to long time horizen. A greater
importance is placed on the return potential of an
investment than on its safety. A moderate amount
of risk aversion tempers the pursuit of higher
Tetums.

80-100 Aggressive

The aggressive investor values high retums
relatively more than other types of investors. The
aggressive investor is able to tolerate both large
and frequent fluctuations in portfolic value
exchange for a higher returm.

Tom and Marilyn Jones
Presented by: John A Smith

Continued..

Figure 10: Client Presentation — Asset Allocation — Risk Tolerance Assessment

The Risk Tolerance Assessment audit page explains how risk tolerance and time horizon are matched to
an asset allocation for an objective. Part I of the report shows the clients” answers to the questionnaire,
the weighting given to each answer, the clients” overall score, the suggested portfolio, and its
description. Part II of the report shows the time horizon of the goal. The Time Horizon Score answers
are determined by the start date and the duration of the objective. At the very bottom of the Risk
Tolerance Assessment page is a table showing the time horizon score for different objectives.

Discuss solutions to solve the retirement objective
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Time Horizon Score
Cljective Nene Score

Fetirement 17
Ielizsa 11
Meal 11
Wacation Home 2
Iielissa's Wedding 11

0

Figure 11: Client Presentation — Asset Allocation — Risk Tolerance Assessment (Time Horizon Score table)

Note the score for the retirement objective, and then click Next to go the next output page,
Recommended Allocations.

12 Discuss solutions to solve the retirement objective
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Recommended Allocations
Finding the best allocation for each objective

Time Horizon Recommended
Score Range Asser Allocation FPortfolios
Risk Tolerance Profile: c
Moderate Agzressive Low Risk/Refurn
The table to the right will help 1-2 ‘
d.e:iml_jne’:]ie 1ilghtka:se:]:e]]t0:aﬁiu. For Stocks = 20%
e ez
Cash=10%
Basad on your nisk tolerance profile, the
shaded rows on the table are considered s
too risky for you, v e fime Low-to-Med Risk/Return
horizon. Fows that are o ded are
available to help you meet your various 3.5 ‘
bjectives. -2
Seet Stocks = 40%
Bonds = 53%
Medium Risk/Return
S \
6-7 Stocks = 60%
Bonds = 35%
Med-to-High Risk/Return
8+
Stocks = 80%
Bonds = 20%
High Risk/Return
Not
Available Stocks = 95%
Bonds = 5%

Tom and Marilyn Jones
Presented by: John A Smith

Figure 12: Client Presentation — Asset Allocation — Recommended Allocations

You can use this output page to select the recommended asset allocation based on the clients’
investment profile. Shaded rows are deemed too risky based on the answers to the Risk Tolerance
Profile questions. However, these allocations are only suggestions and do not have to be used. In our
example, the Jones would fall into the 8+ Med-to-High Risk/Return category.

Discuss solutions to solve the retirement objective 13
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M Profiles Professional - Comprehensive
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Profiles Professional . )
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Back | Hest |

Joe B, advizor A

Figure 13: Case Data — Reallocation

You can reallocate asset groups to different asset allocation portfolios for different time periods using
the Case Data — Reallocation screen. For example, you may choose to reallocate the retirement accounts
for the Jones family to a high-risk portfolio for the period, beginning today. The allocation can be
reset again for a set number of years prior to or after an event, such as retirement, or at retirement
itself. For more information about asset reallocation, see the Asset Distribution and Reallocation Self-
Study Guide.

14  Discuss solutions to solve the retirement objective



Reallocation of Current Portfolio
Retirement Accounts
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Tam and Marfyn Jones
Presenfed by: Jos Pismer

Retirement analysis

Figure 14: Client Presentation — Asset Allocation — Allocation of Retirement Accounts — Reallocation of Current Portfolio - Retirement

Accounts

This output page is only available if assets were reallocated in the case. The top of this output page
displays the current asset mix next to the suggested asset mix in a pie graph format. The bottom half
of the page displays the reallocations that occured in order to get to the suggested portfolio.

Discuss solutions to solve the retirement objective 15



HANDS-ON EXERCISES

Profiles Professional Self-Study Guide

Exercises

Exercise 1: Define a retirement objective

1.

N

@

The Retirement screen gives you the option to enter different inflation rates for different retirement
expenses. True or false?

a) True
b) False

What percentage of current income is used to define the initial default retirement need, and where
can you modify this percentage?

a) 70% — Planning Preferences — General Preferences
b) 75% — Planning Preferences — Needs Preferences
c) 75% — Planning Preferences — General Preferences

d) 70% — Planning Preferences — Needs Preferences

On the Planning Preferences — Needs Preferences screen, the Retirement Capitalization Rate is the return
rate applied to additional savings in order to achieve the retirement goal. True or false?

a) True
b) False

Exercise 2: Analyze retirement using output pages

1.

2.

Which output page displays the retirement need only and the amount of capital needed to
fund it?

a) Retirement — Analysis Results
b) Retirement — Retirement Objective

¢) Retirement — Save More—Earn More

The Retirement Analysis Results output page factors in retirement need, income sources, capital
available, and any remaining shortfalls. How could this help your relationship with the clients?

a) Allows you to provide your clients with an overall picture of their retirement goal

b) Provides you the opportunity to work with your clients in establishing strategies going
forward to address potential shortfalls

c) Allows you to gather more information about the clients and potentially discover assets the
clients may not have disclosed in previous meetings

d) All of the above

16 Exercises
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3. Profiles will examine the Risk Tolerance Profile Questionnaire and the time horizon and duration of a
specific objective to determine the most appropriate asset allocation for your clients. True or false?

a) True
b) False

Answers to exercises

Exercise 1: Define a retirement objective
1. a) True

2. d) 70% — Planning Preferences — Needs Preferences
3. a) True

Exercise 2: Analyze retirement using output pages
1. b) Retirement — Retirement Objective

2. d) All of the above
3. a) True

Answers to exercises

17
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